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Final Cut Pro X and AJA

Introduction

Final Cut Pro X is the latest update for Apple's popular non-linear editing software. It
features a new user interface and boasts new, exciting features for editors. However,
the way editors interact with third party tools, like the AJA KONA cards and lo XT, is
different from the previous versions of Final Cut Pro. This document describes how
editors can use AJA products with the latest version of Final Cut Pro.

Note: The information in this bulletin applies to Final Cut Pro X version 10.0.4 and AJA
Version 10.3 driver software for KONA and lo XT.

AJA Recommendations for Configuring Your Final Cut Pro X System

You may want to use Final Cut Pro X right away, but you are likely to have some
projects that you are still working on using a previous version of Final Cut Pro. AJA
recommends that instead of installing Final Cut Pro X alongside your current version
of Final Cut Pro, you create a new boot drive for your computer with a clean Lion OS
install, then install Final Cut Pro X to this alternate boot drive. This way, you can
continue to work on your older version of Final Cut Pro with your AJA products as you
have been and begin to work on the new Final Cut Pro X. This will give you the most
flexibility if you find you need to use the older or newer version of Final Cut Pro.

Note: with respect to the system configurations required for AJA products, refer to
the AJA documentation available on the AJA website. For the recommended system
requirements for using Apple Final Cut Pro X, refer to the Apple website.
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Using AJA Products with Final Cut Pro X

Ensure You Have Current AJA Software

Ensure you've downloaded and installed the very latest current AJA Driver software
for your product that supports Final Cut Pro X. Go to the AJA website support
section to get that software:

http://www.aja.com/support/

Launch the AJA Control Panel
Go to your Applications folder, locate the AJA Control Panel, and then run it.

enon =} Macintosh HD 2
(<> (2B m ] (%] (=] Q
Back View Action Arrange Search
FAVORITES ~ Name +| Date Modified
T v G icati .
= All My Files [55] Applications Yesterday 1:37 PM
- : ——tddrass-Dak Nov 10, 2011 12:46 PM
= AirDrop [UL| AJA ControlPanel Yesterday 1:38 PM
% Applications ¥ [ AJA Unltes Yesterday 10:25 AM
[ Desktop &) App Store Nov 10, 2011 12:46 PM
- ¥ Automator Nov 10, 2011 12:46 PM
"1 Documents - )
] Avid EDL Manager Oct 26, 2011 10:45 PM
) Downloads b [ Avid FilmScribe Oct 26, 2011 10:46 PM
i~ Movies ¥+ (] Avid Log Exchange Oct 26, 2011 10:43 PM
™ aa

Go to the Format Tab
Set the format and frame rate in the Format tab for the output format/frame rate
you'd like to obtain from FCP X.

8006 loXT AJA ControlPanel
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Go to Final Cut Pro X Preferences and Verify AJA A/V Output
In Final Cut Pro X, go to the Final Cut Pro pull-down menu and select Preferences.

About Final Cut Pro

Preferences... S
Commands >

Download Additional Content...

Provide Final Cut Pro Feedback...

Services »
Hide Final Cut Pro #¥H
Hide Others CEH
Show A

Quit Final Cut Pro ®Q

Locate the A/V Playout pull-down menu in Playback Preferences, and note that
A/V Output reports the AJA hardware. For example: AJA 1920 x 1080 @23.98.

und render

optimized media

ality Better Performance

Pre-Roll Duration:

F Roll Duration:

Player Background: Black

AN Qutput: ' AJA 1920 x 1080 @23.9

If the video output from Final Cut Pro X and the AJA hardware is not appearing on
a baseband connected broadcast monitor, first scrub over a clip in an Event, or in
the Project.
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If video out still does not appear, go to the Final Cut Pro Window pull-down menu
and ensure that A/V Output is selected.

Minimize #M
Minimize All

Zoom

Go to Event Browser #}1
Go to Viewer #3
Co to Timeline 82
Co to Inspector 4
Co to Color Board #o
Co to Audio Enhancements a8
Show Project Library #0
Hide Event Library 31
Show Timeline Index {r882
Hide Inspector #4
Show Video Scopes ®7
Show Angle Viewer {87
Hide Audio Meters {+3#8
Media Browser 2
Record Audio

Background Tasks #9

Revert to Original Layout
Bring All to Front
+ Final Cut Pro

Enter Full Screen ~3F

Final Cut Pro video output is set based on the Project. If you need to change from a
23.98 output to a 29.97 output, you may need to quit Final Cut Pro X, change the
format in the AJA Control Panel application and relaunch Final Cut Pro X. For ease of
use, and clarity about the selected video output format and frame rate, you may
keep the AJA Control Panel application open when working with Final Cut Pro X.
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How to Set Sound for the Desired Output

The AJA KONA and lo XT products are Core Audio compliant so you can use them to
output system sounds or audio from a variety of applications. In order to enable this,
you will need to open the System Preferences>Sound.

é&nNnm Systern Preferences
[ «|» || Showall | Q| )

Personal

4 M B @ o @
Appearance Desktop & Dock Exposé & Language & Security Spotlight
Screen Saver Spaces Text
Hardware
2 E al 7 _ = Q
CDs & DVDs Displays Energy Keyboard Mouse Trackpad Print & Fax Sound

Saver

Internet & Wireless

@ 0 @

MobileMe Network Eluetooth Sharing
System
2 ¢ & 6 & @ @
gy 18 o (it
Accounts Date & Time Parental Software Speech Startup Disk Time Machine  Universal
Controls Update Access

Once you have selected Sound, you can then select a device for the sound output.
Choose the AJA device listed in the Output list.

anc Sound
[ <[> |[ Showall | Q

| Sound Effects | Output | Input

Select a device for sound output:

Name

:fype
Internal Speakers Built-in
Line Qut Audio line-out port
Digital Out Optical digital-out port

Settings for the selected device:

The selected device has no output controls

Output volume: * O *))) ] Mute

EShow volume in menu bar

You have now made the appropriate video and audio selections for previewing video
using your AJA KONA or lo XT during editorial using Final Cut Pro X.
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Capturing Clips for Use in Final Cut Pro X

AJA VTR Xchange and Final Cut Pro X

One of the changes to the latest version of Final Cut Pro is the absence of Log and
Capture within the application. For several years, AJA has offered a free application
for capturing clips called AJA VTR Xchange. AJA VTR Xchange, as the name implies, is
a program that allows users to ingest and output to VTRs. This simple-to-use
application can be used to capture clips for use with the new Final Cut Pro X. The
latest version of AJA VTR Xchange offers batch capture capabilities so users can log
clips and capture them just as they used to with the Log and Capture tool found in
previous versions of Final Cut Pro.

Note: AJA VTR Xchange can be downloaded as a stand-alone application from the
AJA support pages for your product. Also note, AJA VTR Xchange only works with
AJA devices, so it can not be used to capture from FireWire based cameras or VTRs.
Always ensure you have downloaded the very latest version of AJA VTR Xchange.

Important: Installing Codecs Before Using VTR Xchange

Another difference between previous versions of Final Cut Pro and the new

Final Cut Pro X is that additional codec support is not installed when you install

Final Cut Pro X. To install additional codecs for use in Final Cut Pro X, such as the
Apple ProRes family of codecs, you will need to perform a Software Update (from
under the Apple icon in the finder) after you have installed Final Cut Pro X and before
using VTR Xchange. You will be installing the ProAppsQTCodecs.pkg from Software
Update.

Note: it is very important that you should perform this step prior to using VTR
Xchange for capturing clips for use in Final Cut Pro. If the additional codecs from
Apple are not installed, a very limited number of QuickTime codecs will appear in the
AJA VTR Xchange application.
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Configuring AJA VTR Xchange

By default, the AJA VTR Xchange application, when it launches, will try to auto-
configure the main Ul viewer so that you see a preview of your incoming video.

Capture: 720p59.94 10Bit (1280x720) Apple ProRes 422

ETEER.

ViR oK 01:07:43:09
Clip Name SC_12_TK4
Name SC Reel 001
Scene 12 | el =
| pee— capture: video v o |
Shot/Take TK4 [ audio [+ . ]
Angle‘_— (] ccl | | capture now | | capture : | | cue to I 91:87:43:29
Preset | Apple ProRes 422 = | graly I | grab: | | CLEdD | Gl:07:43 18

What is auto-configured may or may not be what you want to capture, so you will likely
need to make changes in the Capture>Video Settings and the Capture>Audio settings.

Capture can be found in the Finder pull-down selections for the application.

Capture Now 3K

Audio Settings...



A\ JA

VIDEO SYSTEMS

In most cases, you will likely want to capture to one of the Apple ProRes codecs for
use within Final Cut Pro X. To configure the AJA VTR Xchange application to capture
to one of the Apple ProRes codecs, go into the Capture>Video Settings selection and
choose the Source tab first. Within Source, you will see a list of format types. Since
Apple ProRes codecs are 10-bit, you will want to choose the appropriate format with
the 10-bit indication—for example, 1080i 29.97 10 Bit (1920x1080).

Video

Adjustments Compressjon | Source ]

| 1080i29.97 10 Bit (1920x1080)

| 1080i29.97 10 Bit (1920x1080) DBL
1080i29.97 10 Bit (1920x1080) VFR
1080i30 10 Bit (1920x1080)
1080i30 10 Bit (1920x1080) VFR
1080sf23.98 10 Bit (1920x1080) DBL
1080sf23.98 10 Bit (1920x1080) |
1080sf24 10 Bit (1920x1080) m
1080sf25 10 Bit (1920x1080)
1080p23.98 10 Bit (1920x1080) |
1080p24 10 Bit (1920x1080) A

| 1080p25 10 Bit (1920x1080)

Format | NTSC ¥ 1

Next, you will be selecting the type of compression that you want to work with: Apple
ProRes 422, Apple ProRes 422 (HQ), etc. Click on the Compression tab of the Video
Settings window.
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Video

I Adjustments | -~ Compression| |Source !

Compression type: | Apple ProRes 422 % ]
Motion
Frames per second: | 29.97 1§ 1
Key frame every frames
a rate ti kbits fsec
_ Compressor

Gamma Correction: | Automatic | ]

™ Interlaced | Top field first & ]

Preview: | None o ]

[_| Enable chroma filtering for 4:4:4 sources

No preview selected

Capture from: 1080i29.97 10 Bit (1920x1080)
Compress with: Apple ProRes 422

N
(Caneel)

Once you have selected the Source and the Compression, click OK in the lower right
hand corner of the window.

The next step in configuring your settings is the Capture>Audio Settings. Again, select
Capture from the Finder pull-down and then Audio Settings.

Capture Now 38K Once you have opened the Audio Capture Settings window,
you can elect to change the number of audio channels you
Video Settings...

AL Setti will capture, whether they are dual mono or stereo and what
[ Audio Settings... | format of audio is used.
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Source
Device [ AJAKona3G W8 IEEEE——— ] 1
o 2 [ Stereo
[ =1 |
Input default -
I
2 - - = [ Stereo
Format [ 24-bit Integer (Big Endian), 16 Channels, 48.000 kHz hv'] T ] 4
I S
16 channels, 16-bit Integer (Big Endian), 16 Channels, 48.000 kHz D . D Stereo
T
I ] 7
Stereo .
I (] 2 > 3
Monitor
Device | AJA Kona3G E Volume O 0.05
Output | default i Format | 24-bit Integer (Big Endian), 16 Channels, 48.000 kHz A

C Cancel j 6—@!&—)

Once you have made the settings appropriate for your project, click OK in the lower
right corner of the window.
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Presets Once you have set up capture settings, you can save them at any time by going to the
Capture menu and selecting “Save current settings as a Preset.. This opens a dialog
asking you to enter a name that the preset will be stored under for later recall.

Capture Now #K

Video Settings...
Audio Settings...

Save current settings as a Preset... Enter Preset Name:

| Cancel | | OK J

Save Current Settings as a Preset

To manage your stored Presets, you can rename or delete them—also from the Capture
menu.

To use a stored preset, simply select it from a pull-down menu at the bottom of the
Capture window:

Capture: 720p59.94 10Bit (1280x720) Apple ProRes 422

17
VIR OK 01:07:43:18  nonurep
Clip Name SC_12_TK4
Mame 5C Reel 001 [‘“'“'*I-I'|>|»]
E .I L] /\ | |
capture; video IE‘u i _I_ng | =
S audio (V] e ¥ NN N3
] el | | capture now | | capture ; | | mark in | 01:97:43:89

[a | |arabnow | | | grab: | | markout| 91:97:45:19

-

VTR Xchange, Main Window—YView Current Preset or Select Another Preset
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Logging and Capturing Clips with AJA VTR Xchange

Before you begin logging and capturing clips, you will want to determine where your
clips are saved. Go to the AJA VTR Xchange pull-down and select Preferences. On the
Capture tab of the window, select a location for the Captured Clips Folder by
choosing the Change button.

Note: ensure you select a disk that has an adequate amount of storage space as well
as adequate bandwidth capabilities for the type of codec, format and frame rate that
you are trying to capture.

8.0 Preferences

! Deck | Capture

——
Captured Clips Folder: ( Change... )

/Wolumes/Internal Media/VTRX CAPTURES/

#) save as QuickTime maovie
() Save as Numbered files
Video and audio will be captured to a single QuickTime maovie file.

Preferrad timecode source: | Deck _¢]

Determines which timecode source is applied to captured clips when VTR Xchange
is controlling the deck and the 5D| video source contains RP-188 timecode or the
loHD is receiving LTC timecode.

Use the AlA Control Panel to choose between LTC and RP-188.

ET Abort on dropped frames

ET Open captured files

Use this option if you want files to automatically open after a capture or a grab.
Tip: You can temporarily reverse the checkbox setting by holding down the Option
key when you click capture, capture now, grab or grab now.

After you have selected the desired location for your clips, simply close the
Preferences window.
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The AJA VTR Xchange main window is very easy to operate. It consists of transport
buttons for controlling your VTR (as well as familiar keyboard commands like J-K-L).

Capture: 720p59.94 10Bit (1280x720) Apple ProRes 422

VTR OK 01:07:43:09  ronarer
Clip Name 5C_12_TK4
. B o ‘[«.dlil-lhlﬁw]
Scene 17 ol = : : Y ' :
Shot{Take Tk4  © ST ;Lﬁz% log _i — e
Angle [ ca | | capture now | | capture : | | cueto | @1:@7:43:09
Preset Apple ProRes 422 - | grab now | ‘ | grab: | | cueto | @1:87:45:18

You can shuttle through your material and mark an in and an out point and then use

the log button to create a new Batch Capture List.

Please name this capture session:

SC1

(" cancel ) ( OK )
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(- NN ) Batch Capture List: SC 1
v Reel Clip Name Media Start Media End Duration
001 SC_1_TK1 01:00:03:13 01:00:05:09 00:00:01:21

number of clips: 1 ( Capture. )

total duration: 00:00:01:21

%

Once you have logged all of your clips to the Batch Capture List, you can elect to
capture them all at once. This is as simple as clicking on the Capture button in the
lower right hand corner of the window.

Note: if you want to log clips but perform the capture process later, an XML file is
saved that can be opened and captured from later. Once you have captured clips
successfully, you can move on to working with them in Final Cut Pro X.



Working with Final Cut Pro X and AJA — Clip Window
Clip Window

The Clip window gives information on the media that is captured, such as format. It also
allows for marking an in-point for performing an edit to tape at a specific point, and
selecting whether or not video, audio, and closed captioning will be included when the
edit is performed.

800 [« Player: SC2ATK1.mowv

VTR OK 02:11:09:12 s

— Apple ProRes 422, 1920 x 1080, 29.97 fps
markin | 81:87:43:19 2 audio channels, discrete
1 Reel: 1

out  91:08:00:18

length  90:00:17:00

!'ﬂaio rauting | | add audio tracks.. |

e

Clip Window

The Clip Window allows you to output compatible framerates by enabling a checkbox
at the bottom of the window. In order to output 23.98fps material at either a
compatible 29.97fps or 59.94fps (depending on format), enable the checkbox.

Another feature of the Clip Window is the ability to add audio tracks to an output by
clicking on the “add audio tracks” button. Audio tracks from another QuickTime movie
file or AIFF audio files may be used. Once tracks are added, the number of audio
channels reported in the Ul will increase accordingly. Once the “audio routing” is
clicked, you can then use the audio routing tool to decide which tracks go to which
physical outputs (see “Working with Audio” earlier in this manual). This functionality
can be particularly useful when working with audio which has been assigned Roles
from Apple's Final Cut Pro X software or when receiving audio tracks from a digital
audio mixing or sweetening application that need to be married to the picture for
mastering back to tape.

VTR OK 02:11:09:12 SR
: Apple ProRes 422, 1920 x 1080, 29.97 fps
markin || 81:87:43:19 2 audio channels, discrete | edit to tape |

Reel: 1
aut  91:08:00:18

length  ©0:00:17:00 |

| audio routing | || add audio tracks.. |
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Importing Clips into Final Cut Pro X

Importing Clips into Final Cut Pro X

Final Cut Pro X imports media differently than the previous versions of Final Cut Pro.
Final Cut Pro X allows you to import your clips to an Event. By default, the name of the
event is the current date. You can elect to change this name to whatever you feel
serves your project organization best. You create a New Event via the File pull-down
menu and choosing New Event. Once presented with the Event, name it accordingly
and then choose the Import Files icon presented in the user interface.

L

m

e )

Import Files Import From
Camera

Once you select Import Files, a
prompt will appear which allows
you to locate the clips you'd like to
import.




Working with Final Cut Pro X and AJA — Importing Clips into Final Cut Pro X

e

Import Files
(< »)[22[=/m [3VIRX CAPTURES o Q
» DEVICES Name 4 Date Modified
v (] DEMO 446 PM
SHARED DEMO.xmI 3:11 PM
» PLACES B SC_1 TKl.mow 4:45 PM
SEARCH FOR
MEDIA
) Add to existing Event: | DEMOD :]

O Create new Event:

Save to: Snow Leopard (275.2 GB free)

Organizing: [ Copy files to Final Cut Events folder
™ Import folders as Keyword Collections

Transcoding: |_| Create optimized media

|| Create proxy media
Video: [_| Analyze for stabilization and rolling shutter
| Analyze for balance color

|_|Find people
Consolidate find people results
Create Smart Collections after analysis

Audio: | | Analyze and fix audio problems
| Separate mono and group stereo audio
"] Remove silent channels

( Cancel )

4

Final Cut Pro X provides a variety of selections that users can choose when importing
media. Consult the Final Cut Pro X documentation to decide which settings are
appropriate for your clips and your project. Once you have made the selections that

you feel are appropriate for your needs, click on the Import button in the lower right
corner of the window.

Once your clip is imported into Final Cut Pro X, it will appear in the Event you created.
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Hide Rej

You can now create a New Project. Like the File Import, decide what settings are right
for your project.

Name: lNew Project l

Default Event: | DEMO

aw
)

Video Properties: @ Set automatically based on first video clip

() Custom

Audio and Render Properties: (®) Use default settings (Surround, 48kHz, ProRes 422)

() Custom

( Cancel ) ( OK )

You can scrub, mark in and out points, assign keywords, etc. for your clip and add it to
your project's timeline. Refer to the Final Cut Pro X documentation for details about
editorial.
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Exporting from Final Cut Pro X and Using AJA VTR Xchange to Edit to Tape

Exporting Clips From Final Cut Pro X

Final Cut Pro X changes the way you output files to tape. In previous versions of Final
Cut Pro, an Edit To Tape window was provided for this operation. With Final Cut Pro X,
you first export a QuickTime Movie and then use AJA VTR Xchange to perform an edit
to tape operation.

Note: AJA VTR Xchange only performs insert edits, therefore, you need to be sure to
black and code your tape prior to the edit to tape using the VTR's built in signal
generators, striping the tape with the timecode required for your output.

With a timeline selected in Final Cut Pro X, choose the Share pull-down menu and
select Export Movie.

Q Export your project as a QuickTime movie.

[ Options Summary

Export: | Current Settings :]

Export a movie in the same format as the original project

-

After export: | Open with QuickTime Player Launcher o ]

Include: | Video and Audio : ]

( Cancel ) ([ Next )

In most cases, you can leave the default values in the QuickTime Movie export window
as is. If you want to change the settings, consult the Apple documentation for best
practices and recommendations. Once you have made the desired settings, click on the
Next button. After you click Next, you will be prompted to name the clip and then to
save it. Be sure to export and save the clip to a disk with adequate space and bandwidth
for the file type you are exporting.

If you elected to have the clip open in QuickTime Player, review the clip before
launching AJA VTR Xchange. If you feel there are any changes that need to be made,
make them in your edit and re-export a QuickTime Movie if necessary.
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Using AJA VTR Xchange for Edit to Tape

Launch AJA VTR Xchange. From the File pull-down menu, select Open. Navigate to
the location where the QuickTime Movie you exported from Final Cut Pro X was
saved. Select the QuickTime Movie.

VTR Xchange will open a new Player window for the QuickTime Movie.

800 [# Player: SC2ATK1.mov

VTR 0K 02:11:09:12 s

L ﬁpﬂlﬂ ProRes 422, 1920 x 1080, 29.97 fps
markin | @1:07:43:19 2 audio channels, discrete
e e Reel: 1
aut  @1:08:90:18

length  0@:00:17:09
"‘W |audioruu:ing| |addau|:||'otracks..

You can review the QuickTime movie before you perform the edit to tape. Make the
appropriate selections for the in and out points you want the edit to occur at as well
as the audio routing. When you are satisfied with your selections, click on the edit to
tape button on the right hand side of the user interface. Note: for detailed
information on AJA VTR Xchange operation, refer to the AJA VTR Xchange manual.

After you perform the edit to tape operation, you can review your edit by using the
VTR Xchange main Ul window or you can review the edit directly from your VTR.
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Using AJA Ki Pro Apple ProRes Recorders with Final Cut Pro X

The Value of the AJA Ki Pro and Ki Pro Mini to Apple Final Cut Pro X Users

In 2009, AJA was the first company to introduce an Apple ProRes 422 video recorder,
the Ki Pro. The AJA Ki Pro could be paired with a variety of cameras to produce ready-
to-edit QuickTime Movies for use with Final Cut Pro. In 2010, AJA added the Ki Pro Mini,
a more compact device, to this family of products. Both products are ideal for use with
Final Cut Pro X because they can create QuickTime Movies that are native to Final Cut
Pro X. Ki Pro and Ki Pro Mini files can be copied to your Final Cut Pro X editing system's
storage and then imported into your Final Cut Pro X Events.

= Import Files
(«»] (22 h=d ] [E@AA ) Q
DEVICES Name Date Modified 1
« SCIATK3.mov 6/13/11
SHARED
PLACES
SEARCH FOR
MEDIA
{®) Add to existing Event: | DEMO |

() Create new Event:

Save to:  Snow Leopard (275.2 GB free)

Organizing: E'I Copy files to Final Cut Events folder
Iz'llmport folders as Keyword Collections

Transcoding: || Create optimized media

|| Create proxy media

(1

Video: || Analyze for stabilization and rolling shutter
| Analyze for balance color
|_| Find people

Consolidate find people results

Create Smart Collections after analysis

"I Separate mono and group stereo audio

|_| Remove silent channels

Audio: || Analyze and fix audio problems

{ Cancel (" Import )
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Summary

A New Way of
Editing

Final Cut Pro X introduces new ways of working to editors. Some of the items that are
familiar to longtime users of Final Cut Pro have changed, but the flexibility of Final
Cut Pro X is very compelling. Final Cut Pro X can be paired with AJA desktop products
foringest, editorial and mastering to tape in ways familiar to users. The AJA Ki Pro and
Ki Pro Mini acquisition products can be used for the most modern file-based
workflow possible when working with Final Cut Pro X. The workflows explained in
this document are designed to help users with the transition to this new and exciting
phase of Apple non-linear editing. As Apple's Final Cut Pro X evolves, expect AJA to
provide new and exciting interactions with the software and expand the workflow
possibilities.

If you have further questions beyond the scope of this brief overview document,
consult Apple documentation for Final Cut Pro X, AJA documentation for the KONA
and Ki Pro products. If you still feel you need assistance, don't hesitate to contact AJA
Technical Support via phone or email.

Telephone: 800.251.4224 or 530.274.2048
Support Email: support@aja.com
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